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Recording walk-through
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Quality and consistency are key 
to great presentations. 

To ensure the best recording quality and 

consistency across all presentations, this 

guide will walk you through the steps to 

capture your content and prepare it for 

widespread digital distribution. 

The following pages will go into detail on the following topics

• Getting ready – Pre-record checklist

• Recording – PowerPoint Create Video Feature

• Recording – PowerPoint Screen Recording Feature

• Recording – Windows 10 Camera App

• Uploading Instructions

• General guidance



Pre-session checklist
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A great presentation starts with preparing your 

computer. 

Display settings menu

Ensure that you have all Office and Windows 10 updates 

installed.

Use a wired internet connection if possible.

Turn off all programs except those 

needed to present and run your demos.

Clear your desktop of all non-essential files or folders.

Set your display screen scaling and layout.  We suggest 

starting at 1920x1080 and 100% sale and then testing to see 

if all content that you are presenting is clearly legible. Check 

out this video from Scott Hanselman for tips on preparing 

your desktop for presentations.

Ensure that your environment is 

optimized for presenting. See slide 15 

for general guidance. 

Review guidance for audio hardware. See slide 16 for how to 

improve your audio. 
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https://www.youtube.com/watch?time_continue=2&v=Wu2V8Nr-jeI&feature=emb_logo


Recording tools & options
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Picking the right tool for your presentation is 

key to delivering the best experience possible. 
PowerPoint presentation recording – This tool work well if your presentation is all within 

PowerPoint. This feature records screen activity, voice and camera. Please note: If you have embedded 

videos in your deck those will not record. You will need to upload those videos with your presentation 

and the production team will insert them into the final presentation.

PowerPoint Screen Recorder – This tool works well if your presentation includes sources of content 

outside of PowerPoint such as web content or content within an application running on your desktop. 

It has options for recording cursor and voice but does not include your camera feed. We request that 

if you decide to use the screen recorder feature that you also record an introduction as well as a “wrap 

up” video that our team can add in post-production.

Windows Camera App – This tool works well for recording your camera feed full scree. This in 

combination with screen recording can make for a powerful presentation.

Teams presentation recorder – This tool does well to record both desktop and camera. This is not 

our preferred option due to the image softening that occurs when the video is compressed for 

playback within Stream. Also the camera feed reduces the UI screen to allow room for the camera feed 

window.

Third party Application – If you’re looking to go beyond basics then we suggest Camtasia. Camtasia 

is very powerful tool for screen recording with camera. In addition to editing capabilities you can also 

highlight and zoom to key areas of your presentation. Like all tools there is a learning curve and since 

it is 3rd party, there is a licensing cost as well. 

https://www.techsmith.com/video-editor.html


Recording – PowerPoint Create Video Feature
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Click File > Export > Create a Video. 

Choose Full HD (1080p) from the first drop-down box. 

Choose “Recorded Timings and Narrations” from the second 

drop-down box .

Select “Record Timings and Narrations”. 
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Resources

https://support.microsoft.com/en-us/office/turn-your-presentation-into-a-video-c140551f-cb37-4818-b5d4-3e30815c3e83

https://www.youtube.com/watch?time_continue=2&v=yA7NTQ-dp1c&feature=emb_logo

https://support.microsoft.com/en-us/office/turn-your-presentation-into-a-video-c140551f-cb37-4818-b5d4-3e30815c3e83
https://www.youtube.com/watch?time_continue=2&v=yA7NTQ-dp1c&feature=emb_logo


Recording – PowerPoint Create Video Feature  

continued
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Make sure audio and video are selected

Click “Record” and begin your presentation

When complete, hit “stop” and close out of this menu which 

will bring you back to you PowerPoint. You’ll notice that your 

video and annotations have been added to each slide. See 

resources on slide 8 to learn how to edit each slides narration.

Lastly, you need to save your presentation as a video. Please 

go to >File>Export>Create a video and then save your video. 

It will take a little time to process so please be patient.

Remember to save using this naming convention:

SESSIONCODE_SpeakerName_CAM.filetype
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Recording – PowerPoint Screen Recorder
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To start recording within PowerPoint, open a new or blank 

presentation. On the Insert tab of the ribbon, select Screen 

Recording

On the Control Dock, click on Select Area and either select 

the entire screen for recording or press Win Key+Shift+F. It 

is critical that the entire screen is selected.

PowerPoint automatically records the audio and mouse 

pointer. To turn them off, deselect Audio and Record Pointer 

in 

the Control Dock

To start, click Record or use the following 

key commands:

• Start recording: Win Key+Shift+R

• Pause/resume : Win Key+Shift+R

• Stop recording: Win Key+Shift+Q

When you’re finished recording, save 

your video. Right-click the inserted file 

on the slide that represents the recording and select Save 

Media as. In the dialog box, specify a filename and location.

Please use the following naming convention: 

SESSIONCODE_SpeakerName_PRES.filetype
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Tip: Unless you pin the Control Dock to the screen, it will slide up into the margin while you record. To make the unpinned 

Control Dock reappear, point the mouse cursor at the top of the screen. 



Recording – Windows 10 Camera App
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1 App Settings

• Search for “Camera” in Windows Search

• Select “Camera App”

• Make sure that “video quality” is set to 1080p 30fps in 

settings

Getting ready

On the main navigation “Take Video” button. It may be 

defaulted to pictures.

Set up your shot and center your face within the frame 

Make sure you have good lighting, 

be careful of reflection in your glasses

Click the “Take Video” button again 

to record 

Rename file & upload

When complete, review your video in the lower right corner 

of the App or go the file location located in this folder 

C:\Users\username\Pictures\Camera Roll

Please use the file following naming convention:

SESSIONCODE_SpeakerName_CAM.filetype
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Uploading your videos

Once each part of your presentation has been 

recorded and you’re happy with the result, it’s 

time to upload. 

Follow the link on the right to submit materials 

to the presentation file upload folder. 
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Uploading your video (and slides) as supplementary material at:

https://cmt3.research.microsoft.com/DI2021

https://cmt3.research.microsoft.com/DI2021


General guidance
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Where you’re recording can 
be as important as what 
you’re presenting.

Environment, lighting, video background, 

what your wearing, and equipment all play 

a factor in the quality of the recording. 

This section will cover some general tips 

for looking and sounding as professional 

as possible. 

Section introduction

The following pages will go into detail on the following topics:

• Presentation guidance

• Environment – Setting and lighting

• Wardrobe

• Environment – Audio 

• Audio equipment



Presentation modes

How you present to your audience is important. Varying the 
source of information as you speak keeps your presentation 
dynamic and accommodates diverse learning needs. 

Try to change presentation modes (talking to camera, video, 

PowerPoint, demo, video, interview, etc.) every 3-5 minutes. For 

example, if your presentation is heavy on PowerPoint, consider either 

adding a secondary element (i.e. video), or at least change back to 

camera every so often so that the audience can see you again and have 

a momentary change of pace and medium.

Recording Guide / Going Digital11

Conversational speaking

Remember that your audience is most likely at home 
watching you on a small screen. Sessions are much more 
intimate and on-demand now. 

Speak with energy and with a tone of voice that you would 

normally have, as if you’re holding a conversation with some dear 

colleagues. Your time will go by quickly, as it always does. Keeping 

your content tight, focused, and trying not to repeat yourself helps 

the audience stay engaged.



Environment – Setting and lighting

Take a moment to prepare your recording space.

• An HD webcam is preferred, but a new PC or tablet 

will have a good camera

• Your camera should be stable, at or above eye level.

• Make sure your face is in good, even light, with no harsh backlight. 

In addition, avoid mixing light sources (e.g. window and lamp light) 

as the different color temperatures will show up in the recording. 

• Do not sit in front of a window. Your webcam will compensate, which 

will cause your face to look dim or dark. 

• Reduce clutter and distracting or bright images in the background. 
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Wardrobe

Consider what you plan on wearing and how that will show 
up to your audience. Make sure your wardrobe matches the 
tone of your presentation.

• Please do NOT wear white

• Solid colors work best

• Avoid small prints, stripes, plaid or patterns.

• Unless otherwise specified, shirts with logos and trademarks should 

be avoided

• Avoid noisy jewelry (necklaces, bracelets, earrings) as it can be 

distracting to the viewer.



Environment – Audio

Find a quiet location, sit for a minute and listen 
to your environment. 

Can you hear noises in the hall, an air conditioner, or the buzz of a 

fan in your computer or laptop? These things can have an impact on 

the quality of your audio. 

Try to pick a space that is smaller and with soft walls such as curtains. It 

will keep the sound from bouncing around which will make your audio 

sound hallow. Finally, make sure to turn off any nearby mobile devices.
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Audio equipment

It’s best to have a headset if possible. A USB mic is preferred.

Wired headsets can be a good alternative to the USB microphone. You 

will want to find a quality headset microphone that does not obstruct 

your face too much since your image will be visible in most cases. 

Be sure to keep the headset microphone about a half inch off your face. 

Soft spoken words tend to get garbled for the listener on the other end. 

Speaking up and keeping your level consistent will also help listeners 

set their volume correctly.

Two options we recommend for recording:

Logitech USB Headset H570e Stereo & Yeti by Blue

https://www.amazon.com/Logitech-USB-Headset-H570e-Stereo/dp/B00MUTWMN2/ref=as_li_ss_tl?keywords=logitech+headset&qid=1565390617&s=electronics&sr=1-11&linkCode=sl1&tag=diabeticbooks&linkId=586658420139b192a060b236d630c62a&language=en_US
https://www.amazon.com/Blue-Microphone-Slate-Studio-Filter/dp/B07MN1YGLW/ref=sr_1_26?crid=R1DG2XDBG16G&keywords=blue+yeti+microphone&qid=1585269347&sprefix=blue+yeti+%2Caps%2C221&sr=8-26
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